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Introduction
What this is about and what you gain from it

This ebook is part of an initiative called DIY Hacking (http://diyhacking.com), which has 
been instigated in the hope of inspiring young minds with technology development. It 
aims at imparting pragmatic knowledge through various hands on projects and tutorials. It 
provides tutorials in the realm of the latest technologies, for example: one of the projects 
published in it – Smart Cap, a DIY Google Glass clone, was even featured on Techcrunch.

Technology prototyping has become so facile and swift today that terms like “Rapid Proto-
typing” is used instead for it. New and powerful open source development platforms like 
“Arduino” and “Raspberry Pi” make it easy for even school children to work on robotics 
and other fascinating technologies. These technologies have become an inevitable step to 
gaining profound knowledge about microcontrollers and microprocessors and hence should 
even be made a part of the current academic curriculum. 

There are prolific number of communities and forums surrounding these platforms which 
allow for quick and easy troubleshooting. Furthermore, beginner tutorials in YouTube are 
also very helpful in gaining a better perspective about it. Today, with the advent of 3D print-
ers, now you can even create a custom casing for your project or print your own PCB.

This ebook will act like a beginner’s guide for you to start prototyping using tools like the 
Arduino and Raspberry Pi. Moreover, this ebook has been designed in such a way to pro-
mote self-learning and ingenuity. So, have fun with this ebook and good luck on being a 
Maker!

http://diyhacking.com
http://diyhacking.com/diy-head-mounted-display/
http://techcrunch.com/2014/07/29/indian-inventor-makes-a-decidedly-unsexy-but-cool-open-source-glass-clone/
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A Maker is a person who transforms their project from an idea on paper to reality. Anyone 
who does this and who uses open source tools for the same can be called a Maker. They 
even share their project with the world by posting through online blogs or other platforms 
and thereby contributing back to the same open source community which had aided them 
initially in their work.

Why you should be a Maker?
Being a Maker is extremely beneficial. Apart from letting you stand in good stead in 	
your community it can also:	

•	 Help you in building a good work-experience profile, thereby increasing your chanc-	
	 es of getting a good job.
•	 Help you earn money while in college, by doing part time work for others.
•	 Help you gain good credibility and even get covered by the media and newspapers.
•	 Allow you to work on really cool projects while in college/school.
•	 Keep you updated with the latest technologies around you and help you develop the 	
	 skills for building your own.

DIY - Do It Yourself
DIY stands for Do It Yourself. DIY is one of the most popular acronyms used by Makers 
today. It emphasizes on the fact that - everything could be made/achieved with your own 
effort. 

For example: if you want to make an electric car, you can do that yourself today, because 
of the resources and tons of information relating to that, which is available on the internet 
right now! Don’t believe me? Check out this article and video in it:

Build an electric car

Who is a MAker?
And some other terms you need to know

http://www.treehugger.com/clean-technology/open-source-DIY-electric-car-can-be-built-less-hour.html

http://www.treehugger.com/clean-technology/open-source-DIY-electric-car-can-be-built-less-hour.html 
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The DIY phenomenon has created prolific number of communities and projects which al-
lows you to build absolutely anything, using the knowledge from a collective community, 
instead of just an individual. 

The collaborative and altruistic nature of all the members is the sole reason for its suc-
cess. This means that you can search for queries regarding your project and find innu-
merable solutions or results pertaining to it, instead of relying on an individual.
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What is Open Source?
Open source means that the original project, its design files or even source code is 	
made freely available. You can use this free info for building your projects. 

Makers rely on both open source hardware like: arduino and raspberry pi and also on 
open source software like: python, android OS, etc. 

These data are not confined by any patents; instead they are made available for free, so 
that Makers and DIYers can build upon these free technologies.

Posting to open source
You only become a true Maker when you post your projects online and contribute back 
to the community. Your efforts will in turn help your friends and others in your communi-
ty, just like how you were aided in your initial phases. 

Tools like Github, etc are made available for you to post the source code of your project 
(https://github.com/). You can view several examples of this at: Instructables and DIY 
Hacking.

FYI- If you are viewing this Ebook in a web browser, please press the Ctrl button while 
clicking on the hyperlinks, to open it in a new tab. 

http://www.instructables.com/tag/type-id/category-technology/
http://diyhacking.com
http://diyhacking.com


DIY Projects
Some cool projects you can do later

Arduino Air Drums Project

In this cool DIY, you can see how you can bring an air drum to life by using an arduino. 
Check out this cool video to see what I am talking about:
Youtube Video.

Arduino Coke Can Piano 

You won’t find a better use for used coke cans anywhere else. In this DIY, a Maker has 
turned a bunch of used coke cans into a really cool and versatile musical instrument.
Youtube Video.

https://www.youtube.com/watch?v=jjvy_jzGlAQ
https://www.youtube.com/watch?v=Ttm62RBdOuo
https://www.youtube.com/watch?v=Ttm62RBdOuo 
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Arduino Passcode Lock for Bikes

The main reason that I did this project was because I always used to keep losing the keys 
of my scooter and this resulted in getting a lot of duplicate ones made, each time I loose 
one. So after a lot of frustration, I came up with this idea to use a passcode lock system 
for my scooter; instead of a keypad lock. Check out this video:
Youtube Video.

Raspberry Pi Based Head Mounted Display

In this DIY project, I was able to create a cool head mounted display which was capable of 
mimicking the functions of a Google Glass, as it had: a head mounted display, voice rec-
ognition and first person video streaming using a webcam. It even got featured on Tech-
crunch. Check out this video:
Youtube Video.
The guide to making it (check it out after you’re finished with this ebook): 
Smart Cap Tutorial.

https://www.youtube.com/watch?v=AZ2tjWeCKZY
https://www.youtube.com/watch?v=-sqBGGc_kWw
http://diyhacking.com/diy-head-mounted-display/ 
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Raspberry Pi Powered Autonomous Boat

Check out this cool project, where a Maker has used a raspberry pi to create an autono-
mous/remote controlled boat. It even has a camera that streams a live feed from the boat. 
Youtube Video.
The tutorial: Autonomous Boat Tutorial.

Raspberry Pi Quadrotor

In this project, you can see a quadrotor, which has been built using a raspberry pi. The 
system uses IMU sensors and brushless motors for stabilizing and powering the copter. 
Check out the video:
Youtube Video.
The tutorial: Raspberry Pi Quadrotor Tutorial.

https://www.youtube.com/watch?v=vXgNio2lJWU#t=93

http://www.instructables.com/id/Making-an-autonomous-boat-with-a-Raspberry-Pi-a-/?ALLSTEPS 
https://www.youtube.com/watch?v=Vlv6xCv-Tt0 
http://www.instructables.com/id/Autonomous-Cardboard-Rasberry-Pi-Controlled-Quad/?ALLSTEPS 


Arduino 
The easiest electronics development platform

What is Arduino?
Arduino is an open source microcontroller board designed for quickly prototyping an elec-
tronic project. It is an embedded electronics platform, which uses a programming language 
comprising of simple and easy C/C++ functions. It is a perfect tool that can be used for 
working on your school/college projects or to quickly prototype a cool product idea. 

Arduino is usually interfaced with various sensors like: motion sensors, temperature sen-
sors, etc, either individually or collectively and whose output signals act as an input to ar-
duino, based on which we can program it to do certain tasks. To understand the basic logic 
flow model for arduino, consider the following example:
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Suppose that we have connected a temperature sensor (LM35) to arduino and our ob-
jective is to turn ON the air conditioning when the temperature exceeds 27C/80F. For the 
arduino to do that, we program it using the following logic:

if(temperature>27)
{
Turn ON the AC
} 
else
{
Turn OFF the AC
}

The programming jargon used for “Turn ON the AC” and “Turn OFF the AC” will be ex-
plained in detail later.

Now, to get a basic understanding of what arduino is all about and to see some projects 
that are built using it, watch this video:
Arduino Introduction Video.

The video above initially alludes different sensors such as:
•	 Photoresistor or LDR (Light Dependent Resistor) - To measure the intensity of light.
•	 Motion sensor- To detect the presence of a person in a room (using the infra red 		
	 radiations from our body).
•	 GPS (Global Positioning System) sensor- To track something in an outdoor environ-		
	 ment using latitude and longitude coordinates.

The video also demonstrates the working of a project where: the lights in a living room 
switch off when you turn ON the TV. This is done using an IR (Infra Red) sensor, which 
detects the signals coming off from the IR LED of the TV remote. The arduino reads these 
signals through an IR sensor and commands the lights to be turned OFF/ON depending on 
these signal values.

You can do all sorts of cool stuff like this, arduino makes it pretty easy. Most of the projects 
that are built using arduino are even posted as open source with detailed tutorials on plat-
forms like Instructables, DIY Hacking, etc.

https://www.youtube.com/watch?v=CqrQmQqpHXc
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Note- Arduino boards come in various forms and types, a few of them are:
•	 Arduino Uno
•	 Arduino Due
•	 Lilypad Arduino- Can be integrated into clothing.
•	 Arduino Mega- For extra pins and more muscle.

There are also several arduino clone boards like the freeduino, which offer the same func-
tionalities as the arduino, but at a cheaper price (Rs.800 or approx 9$). These boards differ 
only in appearance; their functions and working are all the same. You can buy these boards 
and its sensors online from popular sites like Ebay or others. Moreover, you can even make 
your own arduino boards at home.

Reference link: http://arduino.cc/en/Main/Products?from=Main.Hardware

http://arduino.cc/en/Main/Products?from=Main.Hardware


Getting Technical with Arduino

Some of the chief components that make up the arduino are:

•	 ATMega328 Microcontroller	            							                 		
	 ATMega328 is the brain of Arduino, all the programming and software associated 		
	 with arduino is loaded inside this. It offers 32 KB of program memory and runs at 5V.	
		
•	 FTDI (Future Technology Devices International) USB Chip						   
	 This chip is responsible for converting the USB signals (from the PC) into serial UART   	
	 signals, understandable by arduino.								      
	
•	 Voltage Regulator										                                 	
	 This chip is used to provide a constant 5V power supply to the arduino from the 		
	 power jack. Arduino can also be powered alternatively through the USB cable.	
	
•	 Clock Crystal													          
	 The 16 MHz crystal is used as the clock to arduino, it is imperative for applications 		
	 relating to timing, etc.										        
	
•	 Reset Button										                                                                                                                                                           	
	 To reset a program running on the arduino, that is to make it run from the begin-		
	 ning.													           
	
•	 Digital Pin headers												         
	 Digital pins are present for digital control applications and to interface with digital 		
     sensors respectively.										        
	
•	 Analog Pin headers 											         
	 To interface with analog sensors, it can also be used as GPIO (General Purpose Input/	
	 Output) pins.

For more information, please check out: http://www.arduino.cc/en/Reference/Board

http://en.wikipedia.org/wiki/ATmega328
http://www.arduino.cc/en/Reference/Board
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Pin Assignments
To connect a sensor or a motor to an arduino, you need to connect them to its pins. Hence, 
you’ll be using them for all your projects. The three different types of pins and their uses 
are:

1.	Power Pins													           
	 These are the set of 6 pins on the lower left side of the board as in the figure above. The 	
	 ones you would use most frequently from these are:

•	 5V														            
	 To provide a 5V output power supply to your sensors, motors, LEDs or other 		
     components you connect to arduino. The arduino supplies the power to these exter-	
	 nal peripherals.												          
	
•	 GND														            
	 Every component that you connect to the arduino requires a GND (ground) connec-	
	 tion along with the power supply. This pin is used to provide the ground connection 	
	 to those external peripherals.									       
	
•	 3V3														            
	 This pin provides 3.3V power supply to external peripherals like sensors, etc, since 		
	 some of the sensors work at 3.3V instead of 5V.



15

2. Analog Pins
The six analog pins in the arduino (0-5) are used to connect to analog sensors. These 	
pins have the capability to convert the analog signals or voltages from these sensors 
into digital (in the range 0-1023) using the ADC (analog to digital converter) on the AT-
Mega328. Pins 4, 5 are also used for I2C communication with sensors like IMU (Inertial 
Measurement Unit), etc.
Reference link: http://arduino.cc/en/Tutorial/AnalogInputPins

For example: if you need to connect a light sensor (LDR), you connect it to one of the 
analog pins. The variations in light intensity are interpreted in the form of voltage varia-
tions from 0-5V, which are converted into the digital range 0-1023, by arduino. 0- being 
the lowest intensity of light and 1023- the highest intensity. 
Reference video: Arduino LDR Tutorial.

3. Digital Pins
The digital pins in the arduino range from 0-13. These pins are used for connecting LEDs, 
motors, or even digital sensors to arduino. These are called as GPIO (General Purpose 
Input/Output) pins, since they can be used for either taking inputs from sensors or can 
be used to control output devices like LEDs. These pins can provide a maximum of 5V to 
power output devices like LEDs or relays.
These pins (0, 1) also support UART communication, to communicate with sensors like 
bluetooth, xbee, etc.

http://arduino.cc/en/Tutorial/AnalogInputPins 
https://www.youtube.com/watch?v=d_4R3ZModcs
https://www.youtube.com/watch?v=d_4R3ZModcs 


Hands - On with your Arduino

The following are the stuff you need to have with you, in order to start working on your 
arduino project:

1.	Arduino or arduino clone board. 
2.	USB programming cable.
3.	Laptop/PC.
4.	Arduino IDE (Integrated Development Environment).

First Step - Downloading the Arduino IDE on your Computer

To download the arduino software, go to: http://arduino.cc/en/main/software and select 
the latest version of arduino and your respective operating system and download it.

Since the downloaded file is a zip file, you just need to extract it and then click on the ardui-
no application to launch it.

To see this in action, watch this video from 4:40: Arduino Installation Video.

http://arduino.cc/en/main/software
 https://www.youtube.com/watch?v=fCxzA9_kg6s&list=PL6797398B58895F92&index=1 
https://www.youtube.com/watch?v=fCxzA9_kg6s&list=PL6797398B58895F92&index=1
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The earlier video is just one of the several arduino tutorial videos which are available on 
youtube, you can refer them for learning about arduino in detail.

Second Step - Hooking up arduino to your computer

Use the USB cable to connect your arduino to your computer and check to see if the power 
light on the arduino is ON.
If you find that the driver is not successfully installed, refer to the video given above to 
view the solution.

Now, we need to find the COM port assigned to your arduino (this is a serial port assigned 
to each serial device that is connected to your computer). 

			   The Arduino IDE
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For doing this:												          
	

1.	First open the arduino IDE and disconnect your arduino from your computer, then 
go to: Tools → Serial Port and find out the names of the serial ports listed there and 
note them down.											         
	
2.	Next, connect the arduino to your PC and again go to: Tools → Serial Port and check 
to see if a new COM port has come up this time, by comparing with the list you noted 
earlier. This new COM port is the one assigned to your arduino.

Furthermore, select your arduino board from: Tools → Board, most of the boards out there 
are Arduino Uno, so select Arduino Uno.

Third Step - Loading your First Arduino Program

Now, we’ll try to blink an LED using arduino. There are several example programs available 
for the arduino, you can access them from: File → Examples. To program the arduino to 
blink an LED, you can view the example program from: File → Examples → Basics → Blink.

This is a video which shows how the program is uploaded to the arduino board and how 
the LED is connected to it.

Arduino LED Blink Video.

https://www.youtube.com/watch?v=EFp6oE26__k
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This is the program code for the above program to blink an LED, “//” represents com-
ments, which are not read during program execution:

void setup()  {
pinMode(13,OUTPUT);    //assigns digital pin 13 as the output pin 
}

void loop()  {
digitalWrite(13, HIGH);     //sets pin 13 to 5V
delay(1000);  		  //maintains pin 13 at 5V for 1000ms or 1 second.
digitalWrite(13, LOW);     //sets pin 13 to 0V
delay(1000);  	            //maintains pin 13 at 0V for 1000ms or 1 second.
}

After uploading this code, by pressing the upload button on the arduino IDE, you will no-
tice an LED blinking on the arduino.
Note - In arduino, by default there is an LED connected to pin 13 on the board, so it’s not 
necessary to connect an external LED to it.

Congrats! You have now successfully run your first arduino program.



Programming in Arduino

Here, let us consider an example of switching an LED ON using a button switch. The connec-
tions are made as per the following image.

Based on the above example I will be explaining the programming structure in arduino. 
Here, we need to find the state of the button press and switch ON the LED accordingly. 
Furthermore, if the button is pressed, a HIGH (5V) voltage is passed to the digital pin; else a 
LOW (0V) voltage is passed. 

The two basic functions that are used in every arduino program are:

•	 void setup()													           
	 This function is used to set up the pins, baud rate, etc of the arduino for a particular    	
	 program. It is run only once initially, unlike the void loop(). It is used to define pins 		
     as input/output, set the baud rate for communication, etc. 	    				  
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	 An example of its use: 											         
															             
	 void setup()  												          
	 {														            
	 pinMode(2,  INPUT);	    //sets digital pin 2 as INPUT pin for a button switch
	 Serial.begin(9600);	              //sets baud rate for communicating with your computer 	
												            at 9600bps.
	 }													           
	

•	 void loop()													           
     This function is the main program loop of arduino. Everything that the arduino is 		
     supposed to do is written inside here. The code written inside this function keeps  		
	 repeating again and again until it is programmed over the next time.				  
															             
	 Here, digital value 0 indicates no or LOW voltage and digital value 1 indicates HIGH   	
	 voltage. 													           
															             
	 An example of its use:											         
															             
		  void loop()  {												         
		  int button=digitalRead(2);   //reads the state of the button switch on pin 2.		
															             
		  if (button == 0)		     //if the button is not pressed					   
		  {													           
		     digitalWrite(3, LOW);	    //turn the LED on pin 3 OFF					   
		  }													           
													           

		  else if (button == 1)	  //if the button is pressed
		  {
		    digitalWrite(3, HIGH);	 //turn the LED on pin 3  ON
		  }
	
           Here, the if-else statements determine whether the LED should be turned ON/OFF.      	
	 Thus, when the arduino detects a button press, it turns ON the LED, else switches it 	
	 OFF.
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Some popular functions in arduino:

•   digitalRead()													           
     Used to read digital signals from a switch or sensor. 							     
     Syntax: digitalRead(1);

•   digitalWrite()													           
     Used to output voltages: HIGH (5V) and LOW (0V). 							     
     Syntax: digitalWrite(1, HIGH);
												                
•   analogRead()													           
     Used to read analog voltage signals from a sensor. 							     
     Syntax: analogRead(0);

•   analogWrite()													           
     Used to output voltages in the mapped range of 0-1023 (0-5V). 					   
     Syntax: analogWrite(1, 700);										       
	
•   Serial.print()													           
     Used to print or view data from the sensors via the arduino serial monitor.                	                                                	
     Syntax:Serial.print(“hello”); 

•   delay()
     To delay the next command for a particular period. 							     
     Syntax: delay(1000);



Interfacing Sensors with Arduino

LDR (Light Dependent Resistor)
Purpose - To detect intensity of light.
Connection - To arduino analog pins.
Example - It can be used to create an automatic emergency light, which turns itself ON us-
ing an arduino when the lights in a room turn OFF due to power supply failure.
Reference -  Youtube Video.

PIR (Passive InfraRed) Motion sensor
Purpose - To detect the presence of a person in a room.
Connection - To arduino digital pins.
Example - It can be used to automatically turn ON the lights in a room, when a person or a 
group of people walks inside.
Reference - Youtube Video.

https://www.youtube.com/watch?v=d_4R3ZModcs

https://www.youtube.com/watch?v=dv1v00Nytbk
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Ultrasonic Distance Sensor
Purpose - To detect the distance from nearest object.
Connection - To arduino digital pins.
Example - To build an obstacle avoiding robotic car. 
Reference - Arduino Ultrasonic Sensor Tutorial.

http://arduino.cc/en/Tutorial/Ping?from=Tutorial.UltrasoundSensor
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Force Sensitive Resistor (FSR)
Purpose - To detect the applied force.
Connection - To arduino analog pins.
Example - Can be placed under the door mat, outside your door and used to detect guests 
at your home, when they step over the mat.
Reference - Arduino Force Sensitive Resistor.

IMU (Inertial Measurement Unit) Sensor
Purpose - To detect movement in 3D space.
Connection - To arduino I2C pins (analog 4,5), other variants use normal analog pins too.
Example - If you have this sensor placed on your hand, you can program arduino to control 
a robot or other stuff based on the gestures you make with your hand.
Reference - Arduino IMU Sensor.

https://learn.adafruit.com/force-sensitive-resistor-fsr/using-an-fsr
http://42bots.com/tutorials/arduino-uno-and-the-invensense-mpu-6050-6dof-imu/



Arduino DIY Project - Auto Lights

Wouldn’t it be cool if we could eliminate darkness? In this beginner arduino project, I have 
posted a very simple project that focuses on eliminating darkness.
What it does is that- whenever a room gets dark due to a fused bulb or any other factors, a 
light bulb automatically turns ON. This can be used even as an emergency lighting system, 
which automatically turns a light ON whenever there isn’t sufficient light in a room. 
Here, in order to detect the intensity of light or darkness, we use a sensor called LDR (Light 
Dependent Resistor). The LDR is a special type of resistor which allows higher voltages to 
pass through it (low resistance) whenever there is high intensity of light and passes a low 
voltage (high resistance) whenever it is dark. We can take advantage of this factor of the 
LDR and use it in our DIY project. Check this link to know more about LDR.

What are the stuff required to do this project?

Hardware:
Arduino or an arduino clone board (freeduino).
LDR (you can buy it online or from a local electronics store very cheaply)
5V SPDT Relay
9V Battery and connector
Connecting wires

Software:
Arduino IDE

 

https://www.kitronik.co.uk/blog/how-an-ldr-light-dependent-resistor-works/
http://robokits.co.in/shop/index.php?main_page=product_info&cPath=6_72&products_id=388
http://www.bhashatech.com/22-freeduino-usb.html
http://www.myroboshop.com/product.php?id=MRBS137
http://www.tenettech.com/product/1655/relay-spdt-sealed
http://arduino.cc/en/main/software


How does it work?
This system works by sensing the intensity of light in its environment. Here, the sensor that 
can be used for detecting light is an LDR, you can buy it from any local electronics store or 
online, for a very cheap price.
The LDR gives out an analog voltage when connected to Vcc (5V), which varies in magni-
tude in direct proportion to the input light intensity on it. That is, greater the intensity of 
light, greater will be the corresponding voltage from the LDR. Since the LDR gives out an 
analog voltage, it is connected to the analog input pin of the arduino. The arduino, with its 
inbuilt ADC (Analog to Digital Converter) then converts the analog voltage (from 0-5V) into 
a digital value in the range of (0-1023). Thus, when there is sufficient light in its environ-
ment or on its surface, the converted digital values read from the LDR through the arduino 
will be in the range of 800-1023. 
Furthermore, we then program the arduino to turn ON a relay and hence correspondingly 
turn ON an appliance (light bulb), when the light intensity is low (can be done by covering 
the surface of the LDR with any object). That is, when the digital values read are in the 
higher range than usual.

Step 1: Connecting the components together
First of all, you need to connect the LDR to the analog input pin 0 of arduino. You have to 
use a voltage divider configuration to do this. The connection diagram for the arduino is as 
given below:
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Here, one leg of the LDR is connected to VCC (5V) on the arduino, and the other to the an-
alog pin 0 of the arduino, a 100K resistor is also connected to the same leg and grounded.

Step 2: Uploading the code and testing the LDR
Now, after connecting the LDR to arduino, we can check for the values coming from the 
LDR via arduino. For this, connect the arduino via USB to your PC and open up the arduino 
IDE or software. Now, paste this code and upload it to arduino:

int sensorPin = A0;   // select the input pin for ldr
int sensorValue = 0;  // variable to store the value coming from the sensor
void setup() {
    Serial.begin(9600); //sets serial port for communication
}
void loop() {
   sensorValue = analogRead(sensorPin);   // read the value from the sensor   
   Serial.println(sensorValue); //prints the values coming from the sensor on the screen
   delay(100);                  
}
After uploading the code, click on the button on the arduino IDE called “Serial monitor“. 
This will open a new window, which prints different values on the screen.  Now, test out 
the sensor, block its surface from light and see what all values you get on the serial moni-
tor. This is how it looks:
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Step 3: Connecting the relay to arduino
A relay is an electro mechanical switch; it can be used to turn ON/OFF an appliance work-
ing on AC/DC. Here, when the arduino supplies HIGH voltage (5V) to the relay, it turns it 
ON (the switch is ON), else it remains OFF. You can learn more about it in detail here. 
In this project, we are using a 5V SPDT (Single Pole Double Throw) relay and connecting 
one terminal of the coil to arduino digital pin 2, and the other end to GND. We are con-
necting a light bulb to it as well, since we are dealing with high power AC voltages, do 
take proper precautions. If you are still confused about connecting a relay to an appliance, 
check this link. The overall circuit is now as shown: 
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After connecting the arduino as shown above, next we need to test it by uploading the 
final code to arduino. The final sketch can be found here: arduino code.
In this sketch, we have set a threshold light value as 700, but it can vary for your projects, 
you need to find out the particular value, below which the light bulb should turn ON. This 
needs to be done after testing it empirically. So basically, the arduino turns ON the light 
bulb (via the relay) whenever the light intensity falls below 700, and when it is above 700, 
it turns the light bulb OFF. Finally a video showing it in action: 

Youtube Video.

To know more about this project and others, check out: http://diyhacking.com.

http://www.learningaboutelectronics.com/Articles/How-to-connect-a-single-pole-double-throw-relay-in-a-circuit
https://www.controlanything.com/Relay/Device/RELAY_LOGIC
http://diyhacking.com/projects/ArduinoNoMoreDarkness.ino
https://www.youtube.com/watch?v=oqgnAOiZano

https://www.youtube.com/watch?v=oqgnAOiZano

http://diyhacking.com


Some Arduino DIY Projects

Secret knock detecting lock
Protect your privacy by making your own intelligent door lock that unlocks based upon a 
pre programmed secret knock combination. Watch it in action:
Youtube Video.
Tutorial: Instructables Tutorial.

Arduino kitten feeder
Make an automated pet feeder with this easy tutorial. It uses a linear actuator to pass the 
correct amount of pet feed.
Tutorial: Arduino Kitten Feeder Tutorial.

Smartphone controlled robot
Make a really cool android smartphone controlled robot with this tutorial. Use your smart-
phone as a remote control, to control your robotic car. Watch it in action:
Youtube Video.
Tutorial: DIY Hacking Tutorial.

And several more, available on http://diyhacking.com/ .

https://www.youtube.com/watch?v=zE5PGeh2K9k

http://www.instructables.com/id/Secret-Knock-Detecting-Door-Lock/?ALLSTEPS

http://mad-science.wonderhowto.com/how-to/build-vacation-pet-feeder-with-diy-linear-actuator-0134695/

https://www.youtube.com/watch?v=LuJ7l4kBp-0

http://diyhacking.com/make-android-controlled-robot/

http://diyhacking.com/


Additional Resources and Tutorials

Arduino Tutorial Series: 
Check out this arduino beginner tutorial series to get a feel of working with arduino, there 
are several other tutorial series similar to this available on YouTube:
Arduino Youtube Tutorial Series.

Support and guidance:
Whenever you are beleaguered with errors on arduino, you can always search through 
Google for the solution. I can guarantee that there would be several others who would 
have faced the same problems/errors and who would have found solutions to it. Hence, 
readymade solutions to several of them would already be present in the net. 

You can also use arduino forums, to post your queries or doubts regarding arduino, if you 
were unable to find an appropriate solution to it: http://forum.arduino.cc/

https://www.youtube.com/watch?v=fCxzA9_kg6s&list=PLA567CE235D39FA84#t=0

http://forum.arduino.cc/ 


Raspberry Pi
The tiny and super cool mini PC

The raspberry pi is an extremely sleek and tiny computer board. It is about the size of a nor-
mal credit card, and runs on a linux based operating system called the raspbian. This board 
can be thought of as a miniaturized version of the motherboard in your CPU. It might not 
offer the same powerful processing capabilities as a normal PC, but it gets the job done. 
The raspberry pi can be manipulated to turn ON/OFF relays, LEDs, motors, etc using its 
GPIO pins and by using python programming (one of the easiest programming languages).

Just like how you need to hook up your CPU to a monitor, keyboard, mouse and LAN. The 
raspberry pi also offers USB ports for hooking up a keyboard and mouse, an HDMI (High 
Definition Multimedia Interface) port to connect a monitor/TV and an ethernet port to 
hook your LAN cable, to gain internet access. And the raspberry pi is powered using a micro 
USB port on it (5v, 1A), you can use your normal smartphone charger to connect and power 
it.         	           
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Just like you have a hard disk on normal computers, the raspberry pi has an SD card that 
acts as the hard disk. The OS is loaded into the SD card and plugged into the board. You 
can use various memory capacity SD cards: 8GB, 16GB, 32GB, etc.

You can buy these boards online from popular sites like EBay or others for about Rs.2,800 
(40$).

Now, check out this cool introduction video about raspberry pi from raspberry pi.org:
Raspberry Pi Introduction Video.

http://player.vimeo.com/video/90103691?title=0&byline=0&portrait=0&color=cccccc
http://player.vimeo.com/video/90103691?title=0&byline=0&portrait=0&color=cccccc 


Getting Technical with Raspberry Pi

There are different versions of the raspberry pi:
1.	Raspberry pi model A
2.	Raspberry pi model B
3.	Raspberry pi model B+

However, most of the boards out there are model B or B+, so you are more likely to end 
up with them. B+ is the latest and updated version of model B, offering four USB ports and 
other features. Whereas, the model B was introduced as the updated and more powerful 
version of the model A.
The basic specifications of the latest model B+ board are as follows:

Specifications:
Chip 				    Broadcom BCM2835 SoC
Core architecture 		  ARM11
CPU 				    700 MHz Low Power ARM1176JZFS Applications Processor
GPU 				    Dual Core VideoCore IV® Multimedia Co-Processor
				    Provides Open GL ES 2.0, hardware-accelerated OpenVG, and 
				    1080p30 H.264 high-profile decode
				    Capable of 1Gpixel/s, 1.5Gtexel/s or 24GFLOPs with texture filter-	
				    ing and DMA infrastructure
Memory 			   512MB SDRAM
Operating System 		  Boots from Micro SD card, running a version of the Linux			
				    operating system
Dimensions 			  85 x 56 x 17mm
Power 			   Micro USB socket 5V, 2A

Connectors: 
Ethernet 			   10/100 BaseT Ethernet socket
Video Output 		  HDMI (rev 1.3 & 1.4)
				    Composite RCA (PAL and NTSC)
Audio Output 		  3.5mm jack, HDMI 
USB 				    4 x USB 2.0 Connector
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GPIO 				   Connector 40-pin 2.54 mm (100 m) expansion header: 2x20		
				    strip
				    Providing 27 GPIO pins as well as +3.3 V, +5 V and GND supply 
Camera Connector 	 15-pin MIPI Camera Serial Interface (CSI-2)
JTAG 				    Not populated
Display Connector 		 Display Serial Interface (DSI) 15 way flat flex cable connector 
				    with two data lanes and a clock lane
Memory Card Slot 		 SDIO

To view the specifications of the model A, B and B+ and to compare their features, please 
check out: http://elinux.org/RPi_Hardware

The raspberry pi offers USB ports for connecting various peripherals like: keyboards, 
mouse, pen drives, webcams, etc. It also offers a LAN port, HDMI, composite video plugs, 
audio output jack, GPIO pins, etc. Check out the following diagram:

http://elinux.org/RPi_Hardware 
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While working on your robotics or other kinds of projects with your raspberry pi, the GPIO 
pins act as the interface between the board and the external circuit of your project (relays, 
LEDs, motors, arduino, etc). 

GPIO (General Purpose Input/Output) pins

http://GPIO (General Purpose Input/Output) pins
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In order for the board to control these external peripherals, you just need to connect them 
to the GPIO pins and write the corresponding python program to power ON/OFF a partic-
ular pin, which consequently turns ON/OFF the device attached to that pin (LEDs, relays, 
etc).

You can also connect sensors or other peripherals that communicate using I2C (Inter-Inte-
grated Circuit), SPI (Serial Peripheral Interface) and UART (Universal Asynchronous Receiv-
er Transmitter). The raspberry pi has dedicated GPIO pins for communicating using each of 
these protocols as shown above.

For more information on using GPIO pins and to learn to connect an LED to it, check this: 
http://www.raspberrypi.org/documentation/usage/gpio/

http://You can also connect sensors or other peripherals that communicate using I2C (Inter-Integrated Circu
http://You can also connect sensors or other peripherals that communicate using I2C (Inter-Integrated Circu
http://You can also connect sensors or other peripherals that communicate using I2C (Inter-Integrated Circu
http://You can also connect sensors or other peripherals that communicate using I2C (Inter-Integrated Circu
http://You can also connect sensors or other peripherals that communicate using I2C (Inter-Integrated Circu
http://You can also connect sensors or other peripherals that communicate using I2C (Inter-Integrated Circu
http://www.raspberrypi.org/documentation/usage/gpio/ 


Hands - On with your Raspberry Pi
Before moving on to hooking up your raspberry pi, check out this really cool and short 
quick start video from raspberrypi.org: 
Raspberry Pi Quick Start Video.

The tools required for you to begin working on your raspberry pi project are:
1.	Raspberry pi model B/B+
2.	A class 4 SD card (minimum- 8GB) with NOOBS software
3.	Micro USB smartphone charger
4.	USB keyboard
5.	HDMI/composite video cable
6.	HDMI monitor/TV
7.	USB mouse
8.	LAN cable and modem for connecting to the internet (optional, but preferred)

Now, let’s load the OS onto your SD card. Alternatively, you can also buy SD cards that are 
already loaded with this software. Or you can download the NOOBS (New Out Of the Box 
Software) software from: http://www.raspberrypi.org/downloads/
 
Next, connect your SD card to your computer using an USB SD card adapter and extract the 
zip file into your SD card from your computer. For instructions on downloading and copying 
the files to your SD card, check out this video till 01:34 minutes and then go through the 
following link after it:
Installing the OS in Raspberry Pi.

http://www.raspberrypi.org/help/quick-start-guide/

Plug in the SD card to your raspberry pi and power it using your smartphone charger. You 
can now hook up your raspberry pi with a USB keyboard, mouse and to a HDMI monitor/TV 
to boot it up, follow the steps for installing the OS as in the same video above, from 01:34 
and watch it till 04:50 minutes.
Select the Raspbian OS and install it, as it is the recommended and best OS for your pi 
board. If you are stuck with the terminal (black screen with commands), you can enter the 
command “startx” and hit enter, to load the desktop environment and UI (User Interface).

http://player.vimeo.com/video/91631396

The tools required to begin working on your raspberry pi project are: Raspberry pi model B/B+ A clas
The tools required to begin working on your raspberry pi project are: Raspberry pi model B/B+ A clas
The tools required to begin working on your raspberry pi project are: Raspberry pi model B/B+ A clas
The tools required to begin working on your raspberry pi project are: Raspberry pi model B/B+ A clas
The tools required to begin working on your raspberry pi project are: Raspberry pi model B/B+ A clas
The tools required to begin working on your raspberry pi project are: Raspberry pi model B/B+ A clas
The tools required to begin working on your raspberry pi project are: Raspberry pi model B/B+ A clas
The tools required to begin working on your raspberry pi project are: Raspberry pi model B/B+ A clas
The tools required to begin working on your raspberry pi project are: Raspberry pi model B/B+ A clas
http://www.raspberrypi.org/downloads/ 
https://www.youtube.com/watch?v=y4GOG4P-4tY

http://www.raspberrypi.org/help/quick-start-guide/ 
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Congrats! You have successfully booted your raspberry pi for the first time.
You can now begin using your raspberry pi like a normal computer, by navigating with the 
help of a keyboard and a mouse.

				    The Rasbian desktop interface



Python on the Raspberry Pi
Before moving on to learning to program using the python programming language, it would 
be useful if you could check out a few basic linux commands, while working on the termi-
nal. You can access the terminal from the Start menu → Accessories → LXterminal.

Check out this video, showing a few basic terminal commands:
Basic Linux Terminal Commands.

Python is the easiest programming language out there, so you don’t need to hesitate if you 
don’t know to use it. It is recommended to be one of the first computer programming lan-
guages to learn, due to its ease of use.
Check out this documentation from the raspberry pi foundation for python beginners: 
http://www.raspberrypi.org/documentation/usage/python/

To do a simple “hello world” on python, you can either open IDLE or open the Leafpad text 
editor in Accessories, inside the start menu.
In IDLE, you just need to enter:
print “Hello World”

If you are doing it using the Leafpad text editor, type in the above command and then save 
the file name as “test.py” (something.py). The “.py” extension is used to mark it as a python 
script. 
Now, to run this, open the terminal from Accessories and enter the command:
python test.py
It will then print “Hello World”.

					     Hello World in Idle

https://www.youtube.com/watch?v=sEh-VEGci3k
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Now to learn more about python on raspberry pi, check out a few python tutorial videos:
Raspberry Pi Python Tutorial Videos.

Or to learn more about python programming language, check out the several tutorials 
available online, like: Python Tutorial Video Series  and http://www.learnpython.org/ and 
several more!

Next, learn how to blink an LED using a python program and the GPIO pin of a raspberry pi:
Blinking an LED using the Raspberry Pi.

					     Hello World in Terminal

https://www.youtube.com/watch?v=OR5h0UnMcUE
https://www.youtube.com/watch?v=cpPG0bKHYKc
http://www.learnpython.org/
https://www.youtube.com/watch?v=IP-szuon2Bk


Some Raspberry Pi DIY Projects
Raspberry pi powered arcade gaming table

Check out this really cool application of using a raspberry pi to power an arcade gaming 
table. Hook up your pi to a gaming joystick and some buttons to create an arcade gaming 
table.
Check it out in action:
Youtube Video.
Tutorial: Instructables Tutorial.

Face tracking with the raspberry pi
Use a webcam with your raspberry pi and make a cool face tracking system. It can be de-
ployed outside the door of your room to track guests or people. Watch it in action:
Youtube Video.
Tutorial: Instructables Tutorial.

https://www.youtube.com/watch?v=e66lx_bQ4ro

http:// 
http://www.instructables.com/id/Raspberry-Pi-Arcade-Table/

https://www.youtube.com/watch?v=J_GTO9KNNgg
http://www.instructables.com/id/Pan-Tilt-face-tracking-with-the-raspberry-pi/?ALLSTEPS


Home automation using Internet of Things

Check out this tutorial to learn how to control the lights or other appliances in your room 
through the internet. Watch it in action:
Youtube Video.
Tutorial: DIY Hacking Tutorial.

And several more, available on http://diyhacking.com/ and on the internet.
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https://www.youtube.com/watch?v=0y_IFptCZDA

http://diyhacking.com/getting-started-with-internet-of-things-raspberry-pi/

http://diyhacking.com/getting-started-with-internet-of-things-raspberry-pi/

http://diyhacking.com/


Additional Resources and Tutorials

Raspberry Pi Tutorial Series
Check out these tutorial videos on raspberry pi, to learn more about it in detail:
Raspberry Pi Youtube Tutorial Series.

Support and guidance
There is tons of support available for raspberry pi on the internet. Hence, whenever you are 
facing an error or need to troubleshoot, you can search for it online and find solutions for it 
from people who have been in the same situation.

You can also post your queries on http://www.raspberrypi.org/forums/, to get solutions 
from experts on raspberry pi.

https://www.youtube.com/watch?v=OR5h0UnMcUE&list=PLFA4eZ_bEubl_zVY-Dikk7Rpttk2xeWFv

http://www.raspberrypi.org/forums/


Arduino or Raspberry Pi?
Which is the right board for you!

After going through all this information, you might be thinking about which board to use for 
your project idea, or which board is better. However, the arduino and raspberry pi are two 
completely different boards. It would be like comparing an apple with a banana.
Both these boards excel in their particular fields. To bring a bit more clarity to help you 
choose the right board, I will list out a few use cases for each:

Arduino can be used for
•	 Connecting lots of analog/digital sensors.
•	 Connecting lots of motors and servos.
•	 Making a simple and cost effective project.
•	 Making simple robots like: line followers, obstacle avoiding robots, etc.
•	 Performing simple logical operations and programs.
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Raspberry pi can be used for
•	 Connecting LCD touch displays and monitors.
•	 Connecting webcams and performing image processing.
•	 Running highly complex programs, requiring powerful processing.
•	 Making internet dependent applications.

In certain applications, you can even use both the boards together. Here, raspberry pi can 
do complex stuff like processing, image recognition, etc and then the arduino connected to 
the pi via UART can control motors or servos.

To get a better understanding of the differences between arduino and raspberry pi, check 
out this video: 
Comparing the Arduino and Pi Video.

https://www.youtube.com/watch?v=7vhvnaWUZjE



Free DIY Projects
Stay updated on the latest DIY projects

In order to get First and Free access to all latest content from DIY Hacking, including latest 
DIY projects (head mounted displays, wearables, Internet of Things, etc), Ebooks, tutorials 
and other awesome stuff, you just need to do these two things:

	 1 .Just LIKE the Facebook page by clicking on the button below:

	 2. After that on the page, post this message on the wall- “I am a Maker“

I will be adding you to my elite members group through this action and alerting you First on 
all other future stuff that might benefit you.

http://diyhacking.com


3D Printing
An introduction to 3D printing

3D printing is definitely going to be big, so equipping yourself with the knowledge to use 
this, will be a boon for you. 3D printing allows you to make three dimensional objects in 
your home using a 3D printer, you might have used a normal 2D printer to print on paper. 
But, imagine printing a physical object in 3D.

For those of you, who don’t know what 3D printing is all about, check out this video: 
What is 3D Printing.

For printing objects, you can use design files available online (http://www.thingiverse.com/) 
and feed it to the 3D printer for printing that particular object. Or you can even use a 3D 
scanner to scan any object you like to replicate. 
Sketch up is one of the popular 3D designing softwares available: http://www.sketchup.
com/3Dfor/3D-printing

https://www.youtube.com/watch?v=Vx0Z6LplaMU

http://www.thingiverse.com/
http://www.sketchup.com/3Dfor/3D-printing 
http://www.sketchup.com/3Dfor/3D-printing 
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For example: I recently broke the handle on the door of my refrigerator, if I have a 3D print-
er, I could just search for design files of similar handles online and then download the file 
and print it using a 3D printer. These printers use ABS plastic as the ink to print objects in 
3D. 

Check out this video of a 3D printer in action: Live 3D Printing Video.

The future of 3D printing is enormous; it is even used to print human organs, food, weap-
ons, prosthetic limbs and even houses. It can be used for making any physical object or to 
even print another 3D printer. 
Check out this video showcasing the future scope of 3D printing:
 Future of 3D Printing Video.

https://www.youtube.com/watch?v=QnChn7vtWHU

https://www.youtube.com/watch?v=QnChn7vtWHU

https://www.youtube.com/watch?v=QnChn7vtWHU

https://www.youtube.com/watch?v=QnChn7vtWHU

https://www.youtube.com/watch?v=QnChn7vtWHU

https://www.youtube.com/watch?v=QnChn7vtWHU

https://www.youtube.com/watch?v=QnChn7vtWHU

https://www.youtube.com/watch?v=AYRDVMZ3TbY



The Final Step
What is the final step to being a MAker?

A maker is someone who shares their work with the world. They post their projects online 
along with videos and pictures, so that other people would also get benefitted by it, just 
like how you were able to take advantage of this free information.

If you want to become a Maker or if you already are a Maker, please click this button below. 
DIY Hacking will be organizing a bunch of future events including workshops, newslet-
ters, more Ebooks, etc for you guys. We will be letting you know about all these activities 
through the information you have entered here. We will also be providing a platform for 
you guys to post your projects through DIY Hacking. Click this button:

There are lots of platforms you can use for posting your projects online, you can either 
make your own blog using Google blogspot or even post to DIY Hacking, to help friends 
around you, with your knowledge. To post to DIY Hacking, you can contact me at: 		
ars@diyhacking.com and I will be happy to help you out.

You become a true maker or open source contributor, only after posting any of your proj-
ects online. Hence, I strongly encourage you to do the same, that is to give back to the 
community and contribute. 

To get an idea of the format for posting your project to DIY Hacking or other platforms, 
check out this sample project post: http://diyhacking.com/make-line-follower-10-minutes/

http://diyhacking.com
http://diyhacking.com/make-line-follower-10-minutes/ 


The Future
Few examples of the technologies of tomorrow

The future holds many exciting technologies. They range from drones and robots to even 
self-driving cars. Check out a couple of these technologies below.

Some of the most blossoming technologies are those based on drones or UAVs (Unmanned 
Aerial Vehicles). The most common of them are quadrotors. Quadrotors are really power-
ful, since they consist of four propelling motors, that allow to carry huge payloads. Check 
out these videos, showing the power of quadrotors: 

Quadrotor Video 1.
Quadrotor Video 2.

The future also flaunts self driving car technologies. Audi has already created a prototype 
of it, check out this cool auto parking car.

Auto Parking Car.

Robots are also being extensively tested in the military. The future promises to safeguard 
the lives of soldiers by using humanoids and other robots for military missions, Check out 
this cool video of one such robot: 

Military Robots.

https://www.youtube.com/watch?v=w2itwFJCgFQ
https://www.youtube.com/watch?v=pp89tTDxXuI

https://www.youtube.com/watch?v=b_m8DqTlOLE

https://www.youtube.com/watch?v=5FFkDV2NKEY
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Video Promotion - CAT Entertainments
CAT entertainments is an completely inhouse me-
dia production team, with a fully fledged and out-
standingly talented crew. With a vision to create 
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visual depictions of various real world scenarios. 
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shows . Their team of highly talented and cre-
ative individuals strives to deliver high quality 
content to their clients in a timely manner.
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Pitch - In
Help me with this initiative by sharing 

If you like what I am doing, you can even donate to my cause. You can do so either through 
PayPal or can contact me directly at: ars@diyhacking.com 
You can also help me in spreading awareness about this initiative, by simply sharing this 
free Ebook to your friends, and help get the word out; you can do it through Twitter or 
Facebook easily by just clicking below.

The text and content on this Ebook is the work of Arvind Sanjeev.
Licensed under the Creative Commons Attribution-ShareAlike License.

http://creativecommons.org/licenses/by-sa/4.0/
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